
USER GUIDE  

MADCAP FLARE 2020

What's New



Copyright 2020 MadCap Software. All rights reserved.

Information in this document is subject to change without notice. The software described in this document is
furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in
accordance with the terms of those agreements. No part of this publication may be reproduced, stored in a retrieval
system, or transmitted in any form or any means electronic or mechanical, including photocopying and recording for
any purpose other than the purchaser's personal use without the written permission of MadCap Software.

MadCap Software
9191 Towne Center Drive, Suite 150
San Diego, California 92122
858-320-0387
www.madcapsoftware.com

THIS PDF WAS CREATED USING MADCAP FLARE.



CONTENTS

CHAPTER 1

Introduction 6

CHAPTER 2

Private Outputs on MadCap Central 8
How to Customize the Location of the Account Link 10
How to Change the Look of the Account Link 11

CHAPTER 3

Micro Content Enhancements 21
Context-Sensitive Help 22
Conditions 30
Micro Content Variables 40
Phrase Properties 45

CHAPTER 4

Code Snippets 52
How to Create and Insert Code Snippets 54
How to Edit the Content for Code Snippets 60
How to Edit the Styles for Code Snippets 61

CONTENTS iii



CHAPTER 5

Collapsing and Expanding Tags in the XML Editor 66
How to Collapse and Expand Tags 67
How to Enable or Disable the Expand/Collapse Arrows 68
What’s Noteworthy? 68

CHAPTER 6

ServiceNow® Publishing 69
How to Retrieve ServiceNow® Credentials 70
How to Install MadCap Connect for ServiceNow® 71
How to Create a Destination File for ServiceNow® 73
(Recommended) How to Convert Stylesheet Styles to
Inline 76
Multilingual Support for ServiceNow® 77
How to Publish to ServiceNow® 79
What’s Noteworthy? 79

CHAPTER 7

Find and Replace Enhancements 80
Find Text Tab 82
Find Elements Tab 83
Example—Finding All Search Bar Proxies 87
Example—Changing All <h3> Tags to <h2> 89
Example—Changing All <b> Tags to <span
class="Emphasis"> 90
Example—Removing Some Tips (<div> class="Tip") 92
Example—Unbinding Text Popups in a Topic (Returning
to Plain Text) 94
Example—Wrapping Some Bulleted Lists Inside <div>
Tags 97

CONTENTS iv



Example—Adding a "Page" Class to Some Cross-
References 98
Example—Removing a "Center" Class From Paragraphs
in All Snippets 100
Example—Replacing Notes With Tips in All Open
Documents 102
Example—Removing a Style ID From All Topics 104
Example—Adding a Style ID to <div> Tags in Some
Topics 105
Example—Removing Inline (Local) Formatting From
Topics in the Same Folder 107
Example—Setting Inline (Local) Formatting on <h3>
Tags in a Snippet 109
Example—Removing a Language Attribute From All
Topics 111
Example—Replacing the "Mobile" Conditional Attribute
With "Tablet" 113

CHAPTER 8

Deprecated Features 115

APPENDIX

PDFs 116
Tutorials 116
Cheat Sheets 116
User Guides 117

CONTENTS v



CHAPTER 1

Introduction
Following are the new features in this release of Flare.

For more information about each feature discussed in this manual, open the online Help and refer to
the "What's New" topic. Links are provided in some feature descriptions, taking you to topics that
contain additional information and steps.

"Private Outputs on MadCap Central" on page 8

n Produce private output requiring users to log in

n Design account link in a skin

n Set outputs as "private" in Central

"Micro Content Enhancements" on page 21

n Associate context-sensitive Help with micro content phrases

n Apply conditions to micro content phrases

n Use micro content conditions (similar to snippet conditions)

n Edit properties for micro content phrases

"Code Snippets" on page 52

n Create and insert code in dozens of languages

n Syntax highlighting occurs automatically

n Users can quickly copy code in HTML5 output
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"Collapsing and Expanding Tags in the XML Editor" on page 66

n Use arrows, context menu, or shortcuts to expand and collapse blocks of content

n Makes it easier to view and find content in long topics

n Enable or disable expand/collapse arrows

"ServiceNow® Publishing" on page 69

n Publish Flare topics to ServiceNow® knowledge bases

n Select a custom installation component

n Set up a ServiceNow® destination file

"Find and Replace Enhancements" on page 80

n Find text and elements from same window pane

n Easier interface for finding and replacing tags, classes, style IDs, inline formatting, and
attributes

Upgrade to .NET Core 3.1 for Elasticsearch

Previously, publishing Elasticsearch-enabled output required .NET Core 1.1.6 installed on your
server. Now .NET Core 3.1.1 is required. If you have remote Elasticsearch configured from past
versions of Flare, we recommend you upgrade it to the new version, as well as republish older
outputs if possible.

"Deprecated Features" on page 115

n List of features that will be deprecated

n Recommended replacements for deprecated features
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CHAPTER 2

Private Outputs on MadCap
Central
Supported In:

You can produce private output that requires a user to log in with an email and Central password.
Without credentials, people cannot see the output. It is possible to set private output for all output
types supported by Central. Also, accessing private output is not limited to people in your company.
Central has a free Viewer user type that you can use to add any of your customers to your Central
license, and then give them access to live private output.

After users log in to see private output, an account link displays in the output interface for HTML5
targets (not for other output types). If the output is not set to private, this link is not shown. When
users hover over the link, a menu shows two options.
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For more about integrating with Central, see the Flare online Help.

For more details about making output private, see the Central online Help.

This chapter discusses the following:

How to Customize the Location of the Account Link 10

How to Change the Look of the Account Link 11
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How to Customize the Location of the
Account Link

By default, the account link is included automatically in the header of the regular skin. However, if
you want the account link to display somewhere else in the output, you can use a Central Account
proxy and hide the link from the regular skin.

NOTE You cannot use a proxy and skin component to customize the account link location
for Tripane output. It is supported only for Side Navigation, Top Navigation, and skinless
output.

1. (Optional) Add a Central Account skin component if you want to control the look of the
account link in the output.

2. Open a topic (if you want the link to display on only one page) or master page (if you want the
link to display on many pages).

3. In the topic or master page, place your cursor where you want the account link to be added. In
a master page you may need to press the down arrow on your keyboard and then press Enter
at the correct location. Then select Insert > Proxy > Insert Central Account Proxy.

4. (Optional) In the dialog, you can select a skin component to affect the look of the account link.

5. Click OK.

6. Click to save your work.

7. If you inserted the proxy into a master page, make sure to associate the master page with a
target.

8. Open the regular HTML5 skin, and set the account link to be hidden from the top of the
output.

a. In the local toolbar, make sure Web Medium is selected.

b. On the left, select the Styles tab.

c. Scroll down and expand Central Account Element > Layout.

d. Set the Display field to none.

e. Click to save your work.
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How to Change the Look of the
Account Link
1. Open a regular HTML5 skin, or a Central Account skin component if you are using a proxy.

2. In the local toolbar, select the appropriate medium—Web, Tablet, or Mobile. 

3. Select the Styles tab.

4. If you opened a regular skin, scroll down in the Header section to find the Central Account
styles.

Then expand any of the styles.
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Style Description

Central Account Link This controls the look of the area showing the image, text, and
down arrow that the user first sees.

Central Account Link
(hover)

This controls the look of the area showing the image, text, and
down arrow when a user hovers over it.

Central Account Link
Image

This controls the image shown to the left of the word "Account."

Central Account
Element

This controls the look of the entire account link area.

Central Account
Element (hover)

This controls the look of the entire account link area when a user
hovers over it.
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Style Description

Central Account Menu This controls the look of the entire menu area.

Central Account Menu
Link

This controls the look of the link for individual menu items.

Central Account Menu
Link (hover)

This controls the look of the link for individual menu items when a
user hovers over them.
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Style Description

Central Account Menu
Separator

This controls the look of area that separates menu items.

For Tripane skins there is an additional style called "Search Bar and Central Account
Container." This style lets you hide or show the container holding the search bar and Central
account link.

CHAPTER 2  14



5. Expand any of the nodes and complete the necessary fields. The properties and fields that
you see are different for each node. Also, you might see nodes in the full skin that you do not
see in a skin component, and vice versa. Following is a general list in alphabetical order:

ALIGNMENT

Depending on the style and element you are working with, you may be able to select one or
more of the following:

n Horizontal This option lets you choose whether to position the element to the left,
middle, or right.

n Vertical This option lets you choose whether to position the element on the top, middle,
or bottom.

n Full Row This option allows the element to take up all of the space horizontally in the
header.

n Order This option determines which element comes first (1), second (2), or third (3) in
the header. Side Navigation has only two elements (logo and search bar), but Top
Navigation has three (logo, search bar, and menu).
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BACKGROUND

You can change any of the following to affect the background:

n Gradient This lets you change the background color using a progression effect. Select
the beginning gradient color in the first field, and then select a second gradient color in
the second field. You can use any of the following to enter or select a color.

You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color or make
the background transparent.

This opens the Color Picker dialog, which lets you choose a color in
many ways.

Adds a small bar above the cursor. As you move the cursor over any
area of your computer screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click, that
color is automatically loaded into the Color Picker dialog.

n Color This lets you select a single color.

n Image This lets you select an image for the background. Click and use the dialog to
select an image file.

n Repeat Use this field to tell Flare whether the image should repeat or not.

NOTE The Image field has the highest precedence, which means that if you enter
settings in all of the Background fields, the image will win. Gradient has the next
highest precedence. If you want to use the Color field, you need to make sure the
Gradient fields are set to transparent and that there is no image selected.
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BLOCK

This is the container (or "block") holding content in an element. You can change any of the
following to affect the block:

n Line Height This is how tall the container is that holds the content. In the first field type
a number or use the arrows. Then click in the second field and select the unit of
measurement (e.g., pixels, points, centimeters).

n Text Align This changes the alignment of the content. Click in the field and select an
option (center, justify, left, right).

n Text Indent This is how far the text is moved inward. In the first field type a number or
use the arrows. Then click in the second field and select the unit of measurement (e.g.,
pixels, points, centimeters).

n Word Wrap You can click in the Word Wrap field and choose whether to wrap text for
the element (normal) or not (nowrap).
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BOX SHADOW

You can change any of the following to affect the box shadow on the element:

n Horizontal Shadow Length This is the position of the horizontal shadow. Negative
values are allowed. In the first field type a number or use the arrows. Then click in the
second field and select the unit of measurement (e.g., pixels, points, centimeters).

n Vertical Shadow Length This is the position of the vertical shadow. Negative values are
allowed. In the first field type a number or use the arrows. Then click in the second field
and select the unit of measurement (e.g., pixels, points, centimeters).

n Shadow Blur Length This is the blur distance. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels,
points, centimeters).

n Shadow Color This lets you select a color for the shadow. You can use any of the
following:

You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color or make
the background transparent.

This opens the Color Picker dialog, which lets you choose a color in
many ways.

Adds a small bar above the cursor. As you move the cursor over any
area of your computer screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click, that
color is automatically loaded into the Color Picker dialog.

n Shadow Inset This changes the shadow from an outer shadow (outset) to an inner
shadow. Click in the field and select an option. If you select false the shadow will be
outset. If you select true the shadow will be inset.
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FONT

You can change any of the following to affect the font:

n Color This lets you select a color for the font. You can use any of the following:

You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color.

This opens the Color Picker dialog, which lets you choose a color in
many ways.

Adds a small bar above the cursor. As you move the cursor over any
area of your computer screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click, that
color is automatically loaded into the Color Picker dialog.

n Family You can select or type a specific font family (e.g., Arial, Tahoma, Verdana).

n Size You can change the font size. In the first field type a number or use the arrows.
Then click in the second field and select the unit of measurement (e.g., pixels, points).

n Weight You can click in this field and make the font normal or bold.

n Style You can change click in this field and make the font normal or italic.
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HEIGHT

You enter a height for the element. In the first field type a number or use the arrows. Then
click in the second field and select the unit of measurement (e.g., pixels, points, centimeters).

LAYOUT

You can click in the Display field and choose to show the element (block) or not (none).

MARGIN

You can change the margin for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

PADDING

You can change the padding for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

SIZE

You can change the height or width of the element. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels, points,
centimeters).

TEXT DECORATION

You can click in the Decoration field and select a text decoration (e.g., underline, line-through,
overline, underline).

6. Click to save your work.
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CHAPTER 3

Micro Content Enhancements
Supported In:

Major enhancements have been made to the micro content feature, letting you create context-
sensitive Help (CSH), work with conditions, and edit phrase properties.

This chapter discusses the following:

Context-Sensitive Help 22

Conditions 30

Micro Content Variables 40

Phrase Properties 45
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Context-Sensitive Help
The Alias Editor has been modified, allowing you to set CSH identifiers (IDs) on micro content
phrases. And since micro content is intended to be quite short, this makes it ideal for field-level Help
(although it doesn't necessarily need to be associated at the field level). In other words, a single field
in your product's user interface can be programmed to open a specific piece of micro content for
your end users when they seek help. Flare handles the connection between your micro content
phrase/response combinations and CSH IDs; however, to link these IDs to a desktop application,
your engineers would need to work in whatever third-party software they normally use to do their
software development.

Following are steps for creating and assigning IDs at the same time. This assumes you are providing
the developer with the resulting header file (containing the IDs). Alternatively, the developer might
create the header file and provide it to you; you can then import the header file and assign the IDs to
the appropriate micro content phrases.
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How to Set Identifier Options
You can set options for new IDs in advance. This will supply some of the information (e.g., starting
value, prefix, include phrase in ID name) for you automatically as you create new IDs.

1. Open an alias file.

2. In the local toolbar of the Alias Editor click .

3. In the Identifier Options dialog, complete any of the options as necessary. For full descriptions
of all of the options, see the online Help.

Following is the only option that has been changed for this release.

INCLUDE FILE OR PHRASE NAME IN IDENTIFIER NAME

Select this check box if you want the names of the assigned topics or micro content phrases
to be included automatically in the names of the new IDs. This way, you do not have to
manually enter the names later. Flare will add underscores if a file name or phrase hasmore
than one word.
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NOTE The Default Skin option in this dialog applies only to topics, not to micro
content phrases.

4. Click OK.
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How to Auto-Generate New IDs for Many Micro
Content Phrases
If you already have a lot of micro content, you might want to use these steps initially to quickly
create IDs for all of the phrases, but then as you continue to add micro content phrases later, you
might want to use the next set of steps for those (see "How to Create and Assign a New ID for One
Phrase at a Time" on page 27).

1. Open the alias file that you created.

2. Do one of the following:

n In the local toolbar of the Alias Editor click .

n On the right side of the editor, right-click and from the context menu select Auto
Generate.

The Generate Identifiers dialog opens.

3. In the Header File area on the left, select whether to create a new header file from a template
or choose an existing header file.

4. (Optional) On the right side, in the Identifier Options area, you can override values that are
already set in the Identifier Options dialog (see "How to Set Identifier Options" on page 23).

5. In the Generate Identifiers for field, select one of the following:

n Unassigned micro content Select this if you already have some IDs in the header file
that are assigned to micro content phrases. New IDs will be created only for micro
content phrases that are not yet assigned to an ID.

n All micro content Select this if you want new IDs to be created for all micro content
phrases in your project, whether or not some IDs are already assigned to phrases.

NOTE If you also have topics for which you want to create IDs at the same time, you
can select Unassigned topics and micro content or All topics and micro content.
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6. If you selected one of the "All" options in the previous step, choose one of the following in the
Existing Identifiers field:

n Keep Select this if you want to keep the IDs that you already have in the header file. As
a result, you will have some phrases that are assigned to multiple IDs (i.e., the old ID and
the new one).

n Delete Select this if you want to delete the existing IDs in the header file, creating new
ones instead. This way, you will not have any phrases that are assigned to multiple IDs.

7. Click Create. In the Alias Editor, the header file is automatically selected in the local toolbar.
Also, new rows are added in the Alias Editor with (instead of ) next to them. The green
icon indicates that the IDs are assigned to topics.

8. Click to save your work.
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How to Create and Assign a New ID for One
Phrase at a Time

1. Open the alias file that you created.

2. On the left side of the Alias Editor, find and expand the micro content file containing phrases
that you want to assign to new IDs.

3. On the left side of the editor, right-click a micro content phrase, and select Assign to New
Identifier.
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4. (Optional) If you want to make changes (e.g., modify the ID name or number), click in the
appropriate cell and type the new information.

5. Click to save your work.
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What's Noteworthy?

NOTE You can use underscores between words in the ID, but spaces are not allowed.

NOTE The File and Path columns show the name of the micro content file, followed by #,
then the micro content phrase ID. This phrase ID can be changed in the Properties dialog
for the phrase. See "Phrase ID" on page 45.

What's Next?
The process of creating CSH for micro content is essentially the same as it is for topics.

n Author After assigning the IDs to the appropriate micro content phrases, you need to build the
output and make it available to the developer. You also need to share the header file with the
developer if you are responsible for creating it.

n Developer Based on the information in the header file, the developer associates the IDs with
each area of your software's interface. The developer can use a JavaScript or URL method.
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Conditions
The Micro Content Editor lets you work with conditions in a couple of ways for single-sourcing—
"Conditions on Phrases" below and "Micro Content Conditions" on page 33.

Conditions on Phrases
You can apply conditions to individual micro content phrases. This lets you separate the phrases to
be included in different outputs.

HOW TO APPLY CONDITIONS TO PHRASES

1. From the Content Explorer, find and open the micro content file.

2. On the left side of the Micro Content Editor, right-click a phrase, and from the context menu
select Properties. (Alternatively, you can select the phrase and click in the local toolbar or
press F4.)

3. In the Properties dialog, select the Conditional Text tab. The first condition tag set is selected
and the associated condition tags are shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the file, click the check box next to the tag. A
check mark appears in the box.

6. Click OK. The square next to the file name in the Micro Content Editor now takes on the color
of the condition tag. If you applied more than one condition tag to the file, each color is
shown. (If you do not see squares, click in the local toolbar.)
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EXAMPLE You have two HTML5 targets in a project—one named "Target1" and the other
"Target2." In addition, you have a couple of conditions named after each of these targets.
The Target1 condition is associated with green, and the Target2 condition is associated
with orange. Each target is set to include its conditions but exclude those from the other
target.

In a micro content file called "Interface," you have five phrases. You want the phrase "file
format" to be included asmicro content only in Target 1, and you want the phrase
"synchronize" to be included asmicro content only in Target 2. Therefore, you apply
conditions like this.

After building and viewing the Target1 output, you search for each of these. The "file
format" micro content displays.
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But the "synchronize" micro content does not display.

Then you build and view the Target2 output. The "synchronize" micro content displays.

But the "file format" micro content does not display.
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Micro Content Conditions
There might be times when you want to show or hide certain content depending on whether it is
viewed in a regular topic in the output or when it is viewed asmicro content (e.g., in search results).
This is possible for linked responses by using micro content conditions. It is similar to the snippet
conditions feature, but is for micro content only.

HOW TO USE MICRO CONTENT CONDITIONS

1. Create all of the conditions that you plan to apply within micro content responses.

2. Create a micro content file and create phrases linked to responses. This can be done by
tagging content in topics as micro content, or by linking phrases from the Micro Content
Editor.

3. Apply the necessary conditions to the text or other content in the linked responses.

TIP It is a good idea to enable the Hide/Show Conditional Indicators button at the
bottom of the editor so that you can clearly see where the different tags have been
applied.

4. In the Micro Content Editor, right-click the phrase and select Properties.

5. In the Properties dialog, select the Micro Content Conditions tab.

NOTE You will not see this option if you haven't linked the phrase to a response.
Instead, you will see "Snippet Conditions," which can be applied to content entered
directly in the Micro Response Editor, just as it can be applied in a regular topic.

6. If you want to exclude a condition tag from the micro content, select its row to highlight it.
Then click the Exclude option to the right. If you want to include a condition in the micro
content, select its row to highlight it, then click the Include option to the right.

7. Click OK.

8. Click to save your work.

CHAPTER 3  33



EXAMPLE You have a micro content phrase called "lady bird lake," which links to part of a
topic in your project. This response includes a heading, a paragraph, and an image.

When you generate the HTML5 output and search for Lady Bird Lake, you will see all of this
content in the micro content search results. And when you open the topic, you see the
same.
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Suppose you want the image to display only in the topic, but not in the micro content search
results. Therefore, you begin by creating a condition. Let's say you name it "TopicOnly."

In the topic where the content exists, you apply this condition to the image. A small blue
square in the upper-right corner indicates that the condition is applied.
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Next, you open the micro content file, right-click the phrase, and select Properties.
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In the dialog, you select the Micro Content Conditions tab. Then you select the
Default.TopicOnly condition row and set it to Exclude.

After you click OK and save the changes, you build the HTML5 output.
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When you open the topic in the output, you see all of the content, including the image.
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But when you search for Lady Bird Lake, you only see the heading and paragraph in the
micro content.

NOTE If you want to include content in the micro content search results, but exclude it
from the topic in the output, it is probably easier to achieve this using styles.
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Micro Content Variables
There might be times when you want to change the definition to display for a variable, depending on
whether it is viewed in a regular topic in the output or when it is viewed asmicro content (e.g., in
search results). This is possible for linked responses by using micro content variables. It is similar to
the snippet variables feature, but is for micro content only.

How to Use Micro Content Variables
1. Create variables that you plan to use within micro content responses, and add multiple

definitions for those variables as necessary.

2. Create a micro content file and create phrases linked to responses. This can be done by
tagging content in topics as micro content, or by linking phrases from the Micro Content
Editor.

3. Insert variables as necessary in the responses.

4. In the Micro Content Editor, right-click the phrase and select Properties.

5. In the Properties dialog, select the Micro Content Variables tab.

NOTE You will not see this option if you haven't linked the phrase to a response.
Instead, you will see "Snippet Variables," which can be applied to content entered
directly in the Micro Response Editor, just as it can be applied in a regular topic.

6. Click the small down arrow on the right side of the variable row, and select the alternate
definition you want to use for the micro content.
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7. Click OK.

8. Click to save your work.

EXAMPLE You have a micro content phrase called "austin history," which links to part of a
topic in your project. Within the response content, you have inserted a variable that has a
definition of "University of Texas at Austin."

For the micro content search results, you decide you want to use a shortened version of
that—"University of Texas," leaving "at Austin" out of it. Therefore, in the Variable Set Editor,
you add another definition for that variable.
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Next, you open the micro content file, right-click the phrase, and select Properties.

In the dialog, you select the Micro Content Variables tab. Then, next to the variable, you
click the small down arrow and choose the shorter definition.

After you click OK and save the changes, you build the HTML5 output.
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When you open the topic in the output, you see the long version of the variable definition.

CHAPTER 3  43



But when you search for Austin History, you see the shorter version of the definition.
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Phrase Properties
You can edit properties for each micro content phrase by right-clicking the phrase in the Micro
Content Editor and selecting Properties. In the dialog, you can change the following:

n "Phrase ID" below

n "Phrase Title" on page 47

n "Exclude Phrase From Search Results" on page 50

Phrase ID
When you create a micro content phrase, Flare uses that phrase as an ID for it, adding hyphens
between words as necessary.
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This ID is used when you create a CSH ID for the phrase in the Alias Editor. It displays in the File and
Path cells, after #.

If you change the text in this field…

… the CSH ID path changes accordingly.

NOTE The Phrase ID field cannot be empty, and the characters must be lowercase. You
cannot use spaces, underscores, or other invalid characters between words; instead, use
hyphens.
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Phrase Title
Each micro content phrase has a title, and by default, it is identical to the main phrase text.

This title can be used if you create CSH and want to control the text that displays in the browser tab
that opens as a result.
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EXAMPLE Maybe your phrase is "set file format" (lowercase). But you want the browser tab
to display "File Format" (uppercase). Therefore, you change the field as follows.

The window tab in the output therefore displays this.
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NOTE There is also a button to the right of the Phrase Title field that lets you insert
variables as part of the title.
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Exclude Phrase From Search Results
At the bottom of the Phrase Properties dialog is the option Include micro content in search results.

This is similar to the option in the Properties dialog for topics.

By default, micro content phrases and responses will be included in the search results of your
HTML5 output. However, there might be times when you want to exclude a particular phrase and
response from the search results, so you can disable this option for that phrase.
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EXAMPLE You have a micro content phrase called "transfer protocol," and the response for
this phrase describes a specific field somewhere in your product software user interface.

You associate this phrase to a new CSH ID in the Alias Editor, with the idea of producing
field-level Help. When a user clicks a Help button next to this field, the short micro content
response for this phrase appears.

However, when users search for "transfer protocol" in your online Help, this same response
displays in the search results. The problem is that your response was really intended for
field-level Help only, and requires different wording or more information for it to make
complete sense without the context of the interface.

Therefore, you deselect the option in the Properties dialog. As a result, the response will still
be shown in the field-level Help, but it will not be included in the search results.
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CHAPTER 4

Code Snippets
Supported In:

You can create and insert code into documentation in dozens of languages. The syntax is
automatically highlighted according to the language, similar to text editors such as Sublime Text
and Notepad++. In HTML5 output, users can click a Copy button, then paste the code into a third-
party editor.
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This chapter discusses the following:

How to Create and Insert Code Snippets 54

How to Edit the Content for Code Snippets 60

How to Edit the Styles for Code Snippets 61
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How to Create and Insert Code
Snippets
1. Place your cursor in an empty paragraph.

2. Select Insert > Code Snippet.

3. On the left side of the Code Editor, enter or paste code.

4. (Optional) On the right side of the editor, complete any of the options.

n Caption Enter a caption (or title) for the code snippet.

l Position Select whether to place the caption above or below the code.
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l Repeat If you select "Repeat," the caption will be displayed where page breaks are
encountered in print-based output (except Microsoft Word).
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n Language Select the code language. The code will be formatted appropriately, with
syntax highlighting.

If you select "(inherit)," the code uses whichever language is selected for the
MadCap|codeSnippetBody style (the default setting is "PlainText"). So if you change the
setting to a specific language, that language will automatically be used when you first
insert a new code snippet. You can also create classes of that style and assign different
languages to those classes.

EXAMPLE In your stylesheet, you create a class of the style
MadCap|codeSnippetBody, naming it "CSS." Then you create another class and
name it "JavaScript."

On the "CSS" class you set the mc-code-lang property to CSS.
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And on the "JavaScript" class, you set the mc-code-lang property to JavaScript.

When you insert a new code snippet containing CSS, you leave the Language
field set to (inherit). Initially, the code displays as plain text. But after you apply
the CSS style class to MadCap|codeSnippetBody, the syntax highlighting
automatically changes to show the formatting appropriate for CSS.
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You insert another snippet containing JavaScript. This time you apply the
JavaScript style class to MadCap|codeSnippetBody. The syntax highlighting
changes for formatting appropriate for JavaScript.

n Line Numbers Select this to include line numbers to the left of each line of code.

l Starting Number Enter the number for the first line of code shown.
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l Continuous Select this if you are inserting multiple code snippets with line numbers,
and you want the numbering to continue from one code snippet to the other, rather
than starting over.

NOTE If you enter a starting number and select Continuous, the number
entered in the first field is ignored. The continuous setting has precedence.

5. Click OK.

6. Click to save your work.
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How to Edit the Content for Code
Snippets
1. Right-click the code snippet where it has been inserted, then select Edit Code Snippet.

2. In the Code Editor, you can change the text on the left side. You can also adjust any of the
fields on the right side.

3. Click OK.

4. Click to save your work.
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How to Edit the Styles for Code
Snippets
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left of the editor, make sure the drop-down field is set to
.

4. On the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish.

n MadCap|codeSnippet This controls the look of the entire code snippet block. Common
changes you might make to this style are the border, background, or padding.
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n MadCap|codeSnippetBody This controls the look of the code text, as well as the line
numbers and vertical border to the right of the numbers. Modifying most properties is
straightforward; however, if you want the numbers to be different from the rest of the
text (online outputs only), you might need to create a complex (or advanced) selector
called "pre span" and change the properties for that.
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n MadCap|codeSnippetCaption This controls the look of the caption used for the code
snippet.

n MadCap|codeSnippetCopyButton This controls the look of the copy button link that can
be added to code snippets for HTML5 output. If you want to change the word "Copy" to
something else, you can edit the mc-label property.
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5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

There are a couple of MadCap-specific properties that are particularly relevant when editing
the look of code snippets:

n mc-code-border Lets you control the look of the vertical border to the right of the
numbers (if they are included) in a code snippet. Typically, this would be associated
with the MadCap|codeSnippetBody style, or a class of it.

n mc-code-lang Lets you select the coding language to be used by default with the
associated style. Typically, this would be associated with the
MadCap|codeSnippetBody style, or a class of it.
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8. The area to the right of the property is used for selecting and entering values. If you know how
to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

NOTE If you switch the Show drop-down list to another filter (e.g., Show: All
Properties), you can edit additional properties.

9. Click to save your work.
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CHAPTER 5

Collapsing and Expanding Tags
in the XML Editor
When working in the XML Editor, you can now collapse or expand tags (i.e., chunks of content) to
make it easier to view and find content in long topics. With this feature, you can expand or collapse
virtually any block level content.

This chapter discusses the following:

How to Collapse and Expand Tags 67

How to Enable or Disable the Expand/Collapse Arrows 68

What’s Noteworthy? 68
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How to Collapse and Expand Tags
1. In the XML Editor, hover to the left of a heading, paragraph, drop-down, snippet, image, table,

etc.

2. Click the angled arrow .

You also have the option of right-clicking the content or structure bar and selecting Collapse,
or placing the cursor on the content and pressing ALT+SHIFT+C.

If you collapse a heading (determined by the mc-heading-level property), all the content under
it is also collapsed, down to another heading of the same or a higher level.

When a block of content is collapsed, the arrow points to the right and remains whether you
hover over it or not. Also, an ellipsis icon displays at the bottom of the related structure
bar, as well as under the content.

3. Click the right arrow to expand the content.

You also have the option of right-clicking the content or structure bar and selecting Expand, or
placing the cursor on the content and pressing ALT+SHIFT+C.

NOTE You can expand or collapse all blocks of content by clicking or , respectively, in
the local toolbar.
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How to Enable or Disable the
Expand/Collapse Arrows

Do one of the following:

n At the bottom of the XML Editor, click .

n On the local toolbar of the XML Editor, click the down arrow of the Show tags button .
Then select Expand/Collapse.

What’s Noteworthy?
NOTE The collapsed state does not persist when you switch between the XML Editor and
Text Editor, or when you switch between mediums.

NOTE When you collapse a tag that has nested content, that content will also collapse.

NOTE If you collapse a heading and then delete or move it, all content collapsed under that
heading is also deleted or moved.

NOTE The arrows are tied to the structure bars. If the bars are enabled, the arrows can be
enabled. If the bars are disabled, the arrows are disabled.
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CHAPTER 6

ServiceNow® Publishing
Supported In:

If you have a Clean XHTML target, you can publish Flare topics to ServiceNow® knowledge bases.
There are a few setup activities you must complete before you can publish, but most of these are
one-time tasks.

This chapter discusses the following:

How to Retrieve ServiceNow® Credentials 70

How to Install MadCap Connect for ServiceNow® 71

How to Create a Destination File for ServiceNow® 73

(Recommended) How to Convert Stylesheet Styles to Inline 76

Multilingual Support for ServiceNow® 77

How to Publish to ServiceNow® 79

What’s Noteworthy? 79
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How to Retrieve ServiceNow®

Credentials
Before you can integrate Flare with ServiceNow® and publish output, a new entry must be created in
the ServiceNow® application registry. This lets you retrieve the credentials (client ID and secret)
that you will use in Flare.

The following must be done by a ServiceNow® system administrator.

1. Log in to ServiceNow® Service Management.

2. Open the Application Registry.

3. Create a new registration entry.

4. Select Create an OAuth API endpoint for external clients.

5. Provide a name for the entry (e.g., MadCap) and submit it.

6. Open that new entry, and notice the client ID and secret. When creating a destination file in
Flare, you will need to paste each of these when entering credentials. You might need to
toggle the password visibility to copy it.
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How to Install MadCap Connect for
ServiceNow®

To publish output to ServiceNow®, you must make a custom selection when you first install Flare. If
you didn't do this on the initial installation, you can double-click the EXE file you were sent to re-
install Flare. In the wizard that opens, select Modify.

1. When installing Flare, choose Custom as the type of installation, and click Next.
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2. On the next page of the wizard, select MadCap Connect for ServiceNow®. This should be
selected by default.

3. Create a destination, completing the MadCap Connect for ServiceNow® fields.
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How to Create a Destination File for
ServiceNow®

After you have completed the other tasks for publishing to ServiceNow® (i.e., retrieving credentials
and installing MadCap Connect for ServiceNow®), you can create a destination file.

1. Open the Project Organizer.

2. Open an existing destination file or add a new one.

3. In the Destination Editor, click in the Type drop-down field, and select MadCap Connect for
ServiceNow®.

4. Activate your ServiceNow® license.

a. Click Activate. A wizard opens.

b. Enter the license key, then click Next.

c. Enter the name and email of the user associated with the license key. Then click Next.

d. Select either Internet Activation or Manual Activation. Then click Next.

n If you choose Internet Activation, a confirmation displays to indicate that your
license has been activated. Click Finish.

n If you choose Manual Activation, follow the instructions on-screen to copy and
paste the information in an email to customerservice@madcapsoftware.com.

5. In the Destination Editor, click Login Credentials.

6. In the first field, enter the ServiceNow® Instance.

7. Paste the Client ID and Client secret. Then click Next.

8. Enter your ServiceNow® User name and Password. Then click Finish.

9. Complete the MadCap Connect for ServiceNow® fields. Most of these fields are optional, but
you must select a default knowledge base.

n Use TOC to define categories Select this if you want the resulting categories in
ServiceNow® to be based on your TOC structure. Otherwise, the topics will be published
to the default category that is selected.

n Default knowledge base Select the ServiceNow® knowledge base to store the published
files.

n Default category If you have existing categories on the knowledge base, you can
choose one to hold the published files.
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n Exclusions You can enter any files (separated by commas) that you want to exclude
from the publication process.

n Workflow Select the workflow (Draft, Review, or Published) for the output files being
uploaded to ServiceNow®.

n Generate keywords You can choose how the published files affect keywords on
ServiceNow®.

l Use Flare keywords for ServiceNow® keywords Flare keywords will become
ServiceNow® keywords after the files are published. Only Flare keywords without
spaces can be added to ServiceNow®.

l Use Flare concepts for ServiceNow® keywords Flare concepts will become
ServiceNow® keywords after the files are published. Only Flare concepts without
spaces can be added to ServiceNow.

l Delete stale ServiceNow® keywords You might have previously published files to
ServiceNow® that resulted in keywords. If those keywords or concepts no longer
exist in the Flare files being published, selecting this option will remove the out-of-
date keywords from ServiceNow®.

l Default keywords Enter keywords (separated by commas) that you want to be
associated with all published articles in ServiceNow® (even in multiple languages),
whether or not those keywords or concepts were part of the topics in Flare.

n Generate tags You can choose how the published files affect tags on ServiceNow®.

l Use Flare keywords for ServiceNow® tags Flare keywords will become ServiceNow®

tags after the files are published.

l Use Flare concepts for ServiceNow® tags Flare concepts will become ServiceNow®

tags after the files are published.

l Delete stale ServiceNow® tags You might have previously published files to
ServiceNow® that resulted in tags. If those keywords or concepts no longer exist in
the Flare files being published, selecting this option will remove the out-of-date tags
from ServiceNow®.

l Default tags Enter tags (separated by commas) that you want to be associated with
all published articles in ServiceNow® (even in multiple languages), whether or not
those keywords or concepts were part of the topics in Flare.

10. (Optional) In the View URL field, you can enter an address corresponding to your publish
destination. This field is for your own internal purposes, and is simply a quick way for you to
open the output associated with the destination by clicking the button to the right.
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11. (Optional) You can select the following upload options. The Upload Log File option is
automatically selected for ServiceNow®.

n Upload Only Changed Files Select this option if you want Flare to republish only the files
that have changed. This can save significant time.

n Remove Outdated Published Files Select this option if you want Flare to identify files
that were previously published to the destination but are no longer in the source files.
Flare will then remove such files from the destination.

12. Click to save your work.
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(Recommended) How to Convert
Stylesheet Styles to Inline

ServiceNow® does not retrieve stylesheet files from the Flare output. Therefore, in order for the
styles from published topics to appear on ServiceNow®, we recommend that you convert your
stylesheet styles to inline formatting. This is done in the Clean XHTML target.

1. Open a Clean XHTML target.

2. On the General tab of the Target Editor, select Convert stylesheet styles to inline styles.

3. Click to save your work.

CHAPTER 6  76



Multilingual Support for ServiceNow®

You can publish directly in different languages to ServiceNow®.

To do this, make sure the following have been done before publishing Flare output to ServiceNow®:

n Work with a ServiceNow® administrator to make sure you have the following permissions:

l v_plugin Read, write access is required to determine the plugin install status for a
localized upload.

l sys_translated_text Create, read, write access is required for the record- and field-level
properties for creating category translation strings.

n On ServiceNow®, make sure the plugin for each language is installed.

n You might need to switch user interface language in ServiceNow®.

n In Flare, you must have a target that is configured for multilingual output.

Following are the languages that ServiceNow® supports and their Flare equivalents.

ServiceNow®

Language
Flare Language

Chinese (Simplified) Chinese (China)

Chinese (Traditional) Chinese (Taiwan)

Czech Czech

Dutch Dutch (Belgium), Dutch (Netherlands)

English English (United States)

Finnish Finnish

French (Canada) French (Canada)

French French, French (Belgium), French (France), French (Luxembourg), French
(Monaco), French (Switzerland)

German German, German (Pre-reform), German (Austria), German (Germany),
German (Lichtenstein), German (Luxembourg), German (Switzerland)

Hebrew Hebrew, Hebrew (Israel)
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ServiceNow®

Language
Flare Language

Hungarian Hungarian

Italian Italian, Italian (Italy), Italian (Switzerland)

Japanese Japanese, Japanese (Japan)

Korean Korean, Korean (Korea)

Korean Korean, Korean (Korea)

Norwegian Norwegian, Norwegian (Bokmål), Norwegian (Norway)

Portuguese
(Brazilian)

Portuguese (Brazil)

Portuguese Portuguese, Portuguese (Portugal)

Russian Russian, Russian (Moldova), Russian (Russia)

Spanish Spanish, Spanish (Argentina), Spanish (Bolivia), Spanish (Colombia),
Spanish (Costa Rica), Spanish (Dominican Republic), Spanish (Ecuador),
Spanish (El Salvador), Spanish (Guatemala), Spanish (Honduras), Spanish
(Mexico), Spanish (Nicaragua), Spanish (Panama), Spanish (Paraguay),
Spanish (Peru), Spanish (Puerto Rico), Spanish (Spain), Spanish (Uruguay),
Spanish (Venezuela)

Swedish Swedish, Swedish (Finland), Swedish (Sweden)

Thai Thai

Turkish Turkish
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How to Publish to ServiceNow®

After everything is set up and you have created a destination file, you can associate that file with a
Clean XHTML target. Then you can build and publish the output.

1. Open your Clean XHTML target.

2. Select the Publishing tab.

3. Next to your ServiceNow® destination, select the Publish check box.

4. Click to save your work.

5. In the local toolbar, click Build.

6. After the target is finished generating, click Publish in the local toolbar.

What’s Noteworthy?
NOTE Multimedia files, such as MP4 videos, are not be published to ServiceNow®.
However, links to YouTube and Vimeo videos will work.
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CHAPTER 7

Find and Replace
Enhancements
Major enhancements have been made to the Find and Replace feature, including the assimilation of
the Find Elements feature into the same window pane. Therefore, you will now see two tabs in this
window pane: Find Text and Find Elements.
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This chapter discusses the following:

Find Text Tab 82

Find Elements Tab 83

Example—Finding All Search Bar Proxies 87

Example—Changing All <h3> Tags to <h2> 89

Example—Changing All <b> Tags to <span class="Emphasis"> 90

Example—Removing Some Tips (<div> class="Tip") 92

Example—Unbinding Text Popups in a Topic (Returning to Plain
Text) 94

Example—Wrapping Some Bulleted Lists Inside <div> Tags 97

Example—Adding a "Page" Class to Some Cross-References 98

Example—Removing a "Center" Class From Paragraphs in All
Snippets 100

Example—Replacing Notes With Tips in All Open Documents 102

Example—Removing a Style ID From All Topics 104

Example—Adding a Style ID to <div> Tags in Some Topics 105

Example—Removing Inline (Local) Formatting From Topics in the
Same Folder 107

Example—Setting Inline (Local) Formatting on <h3> Tags in a
Snippet 109

Example—Removing a Language Attribute From All Topics 111

Example—Replacing the "Mobile" Conditional Attribute With
"Tablet" 113
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Find Text Tab
This tab functions like the old version of the Find and Replace in Files window pane. It lets you find
and replace text in one or more files in a project. In addition to some organizational and aesthetic
changes, the following are new:

n Find in reviews inbox This looks for the text in files that are contained in the reviews inbox
(Review > File Reviews).

n Create backup (Replace All) This lets you create backups of all edited files that are not open.

n First result per file This option has been moved to a toggle button in the Find Results window
pane.
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Find Elements Tab
This tab functions like the old version of the Find Elements window pane. It lets you find files
containing particular elements—custom tags, MadCap-specific features (e.g., drop-down text,
concepts, equations), markup, inline styles, and style classes. However, it contains several more
features and is much more powerful now.

How to Find and Replace Elements
1. Select Home > Find Elements or press CTRL+N on your keyboard.

2. In the Find and Replace in Files window pane, click the Find Elements tab.

3. In the Find field, click the first drop-down and select a type of element.

n Tag

n Class

n Style ID

n Inline Formatting

n Attribute

4. In the next field(s) to the right, enter or select one of the available options. The field(s) and
options shown depend on your selection in the first drop-down.

5. (Optional) If you want to add more criteria to the find, click Add Row and choose another type
of element. Then complete the field(s) created as a result.

6. In the Replace/Action field, click the first drop-down and select a type of action. If necessary,
complete the field(s) shown to the right.

n Set Tag Adds the selected tag (selector) to the found area; can be used to replace
one tag for another

n Remove Tag Removes the selected tag and its content from the found area

n Unbind Tag Removes the selected tag from the found area, but leaves the content
(mostly useful when you have nested tags and want to remove one or more of them)

n Wrap Tag Places the selected tag around the found area (e.g., you might use this to
place paragraphs within a <div> tag)

n Add Class Inserts the selected style class in the found area
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n Remove Class Removes the selected style class from the found area

n Replace Class Lets you remove one class and replace it with another

n Remove Style ID Removes the selected style ID from the found area

n Set Style ID Adds the selected style ID to the found area; can be used to replace one
style ID for another

n Remove Inline Formatting Removes the inline (local) formatting from the found area

n Set Inline Formatting Adds the inline (local) formatting you entered to the found area

n Remove Attribute Removes the selected attribute from the found area

n Set Attribute Adds the selected attribute to the found area

7. Look at the Preview field to make sure the selected options will do what you expect.

8. Click in the Find in field and select one of the options.

n (current document) Looks for the text in the active document

n (documents in the same folder) Looks for the text in all documents located in the same
folder as the current one

n (all open documents) Looks for the text in all documents currently open in the interface

n (content folder) Looks for the text throughout files contained in the Content Explorer

n (pick a folder) Lets you choose any folder in your project, confining the search to the
files within that folder

n (whole project) Looks for the text in files that are contained in the entire project

n (reviews inbox) Looks for the text in files that are contained in the reviews inbox
(Review > File Reviews)

9. Click in the File types field and select one of the options. This option is disabled if you have
selected to look in the current document only.

n All Supported Files Looks in all of the following file types

n Topics Looks for elements only in topic files

n Snippets Looks for elements only in snippet files

n Micro Content Looks for elements only in micro content files

n Master Pages Looks for elements only in master page files
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10. (Optional) You can expand Options and choose additional features.

n Match case Finds only occurrences that match the case (e.g., uppercase, lowercase)

n Create backup (Replace All) Creates backups of all edited files that are not open when
using the Replace All feature; ignored for files in the reviews inbox (Review > File
Reviews)

n Results view (Find Next/Previous): Lets you choose how to display each instance found
when using the Find Next or Find Previous features

l Current view Displays found instance in whatever view (XML Editor or Text Editor)
the file is currently shown in (if it is already open)

l XML editor Displays each instance found in the XML Editor

l Text editor Displays each instance found in the Text Editor

n Show results in (Find All):

l Window 1 Displays the search results (list of files) in the Find Results 1 window pane
when using the File All feature

l Window 2 Displays the search results (list of files) in the Find Results 2 window pane
when using the File All feature

11. Click appropriate button(s) to take action.

n Find Next Locates the next occurrence of the element

n Find Previous Locates the previous occurrence of the element

n Skip File Skips searching in the current file and moves on to the next one

n Find All Finds and lists all occurrences of the element in the Find Results window pane
at the bottom of the user interface

The label on this button changes to "Stop Find" while a search is being processed. This
is one way to tell that a search is in progress. Another way is to watch the counter in the
Find Results window pane. This shows how many occurrences of matching text have
been found; if the number continues to go higher, the search is still in progress.

n Replace Replaces only the current instance
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n Replace All Replaces all of the matches in all files included in the search

If matches are found in files that are already open, Flare replaces the text in those files
and "dirties" them (i.e., an asterisk is shown in the tab, indicating the file has been
changed and needs to be saved). Therefore, you can undo the changes if necessary in
each of those files or save them. As for files that are not already open in the user
interface, Flare does not open them at all. Instead, it simply replaces all of the matching
text it finds and automatically saves those files. Therefore, you cannot undo those
changes because the files were never opened.

WARNING Exercise caution when you tell Flare to "Replace All." Because
changes are made and files are saved automatically, and because files with
matches are not automatically opened, it is possible that you could introduce
invalid code, therefore breaking files. Therefore, you might consider making a
backup of your project before performing a find and replace like this. If your
project is bound to a source control client, you may also be able to get a
previous version of the files before they were broken.

WARNING If you have content that has been locked for editing and you use the
"Replace All" option, any matching content in those locked sections is replaced
and the files are saved automatically.

n [Progress Bar] A green bar at the bottom of the window pane shows the progress of the
search.
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Example—Finding All Search Bar
Proxies

You have inserted search bar proxies in many content files throughout your project, and you want to
edit some of these proxies.

EXAMPLE Set the fields like this:

n Find

l Tag

l MadCap:searchBarProxy

n Find in

l (whole project)
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After clicking Find All, you see that there are nine files in the project that contain a search
bar proxy, and you can scroll through the list to open the relevant ones.
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Example—Changing All <h3> Tags to
<h2>

You have a lot of <h3> tags throughout your project, and you want to change them to <h2> tags.

EXAMPLE Set the fields like this:

n Find

l Tag

l h3

n Replace/Action

l Set Tag

l h2

n Find in

l (whole project)

Click Find All. After the results are all shown, and you confirm you want to change them,
click Replace All.
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Example—Changing All <b> Tags to
<span class="Emphasis">

You previously applied the <b> tag to text throughout your project in order to make it bold. But now
you want to replace those tags with a <span> tag that has a class that you have named "Emphasis."

EXAMPLE To accomplish this, you need to do two separate find and replace operations.

First, set the fields like this:

n Find

l Tag

l b

n Replace/Action

l Add Class

l Emphasis

n Find in

l (whole project)
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Click Find All. After the results are all shown, click Replace All. All of the instances of the <b>
tag are replaced with <b class="Emphasis">.

Next, set the fields like this (you will need to click Add Row to choose the class):

n Find

l Class

l Emphasis

n Replace/Action

l Set Tag

l span

n Find in

l (whole project)

Click Find All. After the results are all shown and you confirm you want to change them,
click Replace All. All of the instances of the <b class="Emphasis"> tag are replaced with
<span class="Emphasis">.
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Example—Removing Some Tips (<div>
class="Tip")

You have several tips that you've created using a class of the <div> tag (e.g., <div> class="Tip"). You
need to delete some, but not all, of these tips. These tips happen to be inserted in topics stored in
the same folder as the topic currently open.

EXAMPLE Set the fields like this (you will need to click Add Row to choose the class):

n Find

l Tag

l div

l Class

l Tip

n Replace/Action

l Remove Tag

n Find in

l (documents in the same folder)
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Click Find Next. If the tip found is one you want to remove, click Replace. Otherwise, click
Find Next again. Repeat this until you've removed all of the tips you want. Save your
changes.
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Example—Unbinding Text Popups in a
Topic (Returning to Plain Text)

You've inserted several text popups in an open topic, and you now want to turn them all back to plain
text. To accomplish this, you need to do a few separate find and replace operations because text
popups use multiple tags.

EXAMPLE First, set the fields like this:

n Find

l Tag

l MadCap:popup

n Replace/Action

l Unbind Tag

n Find in

l (current document)

Click Replace All. One of the text popup tags is removed; now you need to remove the other.
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Set the fields like this:

n Find

l Tag

l MadCap:popupHead

n Replace/Action

l Unbind Tag

n Find in

l (current document)

Click Replace All. The text popups in the topic all now look like plain text.
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However, the popup text remains in the markup (although it is not visible unless you view
the markup in the Text Editor), so you can remove that too. Set the fields like this:

n Find

l Tag

l MadCap:popupBody

n Replace/Action

l Unbind Tag

n Find in

l (current document)

Click Replace All.
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Example—Wrapping Some Bulleted
Lists Inside <div> Tags

You have some bulleted lists, and you want to place them inside <div> tags. That way, you can later
control those <div> tags (and therefore the lists within them) in some way.

EXAMPLE Set the fields like this:

n Find

l Tag

l ul

n Replace/Action

l Wrap Tag

l div

n Find in

l (current document)

Click Find All. After the results are all shown and you confirm you want to change them,
click Replace All.
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Example—Adding a "Page" Class to
Some Cross-References

You have a folder in the Content Explorer called "PrintOnly," and several topics in this folder contain
cross-references (using the default <MadCap:xref> tag). However, you want all of these cross-
references to use a class named "Page" that you added to the stylesheet.

EXAMPLE Set the fields like this:

n Find

l Tag

l MadCap:xref

n Replace/Action

l Add Class

l Page

n Find in

l (pick a folder)

Then in the dialog, select the folder (in this example, PrintOnly).

n File types

l Topics
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Click Find All. After the results are all shown and you confirm you want to change them,
click Replace All.
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Example—Removing a "Center" Class
From Paragraphs in All Snippets

You've created a generic style class called "Center" to align content in your project. In many
snippets, you've applied this class to several paragraphs to center them. You then decide to remove
that class from the snippets so that the paragraphs in those snippets are all left aligned.

EXAMPLE Set the fields like this:

n Find

l Tag

l p

n Replace/Action

l Remove Class

l Center

n Find in

l (whole project)

n File types

l Snippets
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Click Find All. After the results are all shown and you confirm you want to change them,
click Replace All.
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Example—Replacing Notes With Tips
in All Open Documents

You've created a class called "Note" and another called "Tip," which you've applied to <div> tags
throughout the project. After opening a few topics and snippets, you decide to replace many of the
notes in those files with tips.

EXAMPLE Set the fields like this (you will need to click Add Row to choose the class):

n Find

l Tag

l div

l Class

l Note

n Replace/Action

l Replace Class

l Note

l Tip

n Find in

l (all open documents)
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Click Find Next. If the note found is one you want to turn into a tip, click Replace. Otherwise,
click Find Next again. Repeat this until you've replaced all of the notes you want. Save your
changes.
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Example—Removing a Style ID From
All Topics

You've created a style ID called "Method," which you have added to some tags in many topics
throughout a project. Now you want to remove the ID from all of those locations.

EXAMPLE Set the fields like this:

n Find

l Style ID

l Method

n Replace/Action

l Remove Style ID

n Find in

l (whole project)

n File types

l Topics

Click Replace All.
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Example—Adding a Style ID to <div>
Tags in Some Topics

You've created a style ID called "Method," and you want to add it to certain <div> tags in some of the
topics stored in the same folder as the open topic.

EXAMPLE Set the fields like this:

n Find

l Tag

l div

n Replace/Action

l Set Style ID

l Method

n Find in

l (documents in the same folder)

n File types

l Topics
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Click Find Next. If the <div> tag found is one where you want to add the style ID, click
Replace. Otherwise, click Find Next again. Repeat this until you've added the style ID to the
tags you want. Set the style ID only once per topic. Save your changes.
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Example—Removing Inline (Local)
Formatting From Topics in the Same
Folder

In a subfolder in the Content Explorer, you have some topics that contain local formatting (red and
italic text). Let's say you want to remove the color, but leave the italic formatting.

Open one of the topics in question. When you view it in the Internal Text Editor, you can see how the
inline formatting is written.
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EXAMPLE Set the fields like this:

n Find

l Inline Formatting

l color: #ff0000; font-style: italic;

n Replace/Action

l Remove Inline Formatting

l color: #ff0000;

NOTE If we had wanted to remove all of the inline formatting (not just
some of it), we would have re-entered color: #ff0000; font-
style: italic; here.

n Find in

l (documents in the same folder)

n File types

l Topics

Click Replace All.
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Example—Setting Inline (Local)
Formatting on <h3> Tags in a Snippet

Styles are always recommended over local formatting. However, Flare lets you use inline formatting
if you want.

Let's say you have a snippet with several <h3> tags. Your stylesheet specifies that these headings
should be black and bold. But you want some of the headings to be green (specifically #32cd32),
instead of black.

EXAMPLE Open the snippet, and set the fields like this:

n Find

l Tag

l h3

n Replace/Action

l Set Inline Formatting

l color: #32cd32;

n Find in

l (current document)
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Click Find Next. If the <h3> tag found is one where you want to add the green inline
formatting, click Replace. Otherwise, click Find Next again. Repeat this until you've added
the green formatting to the headings you want. Save your changes.
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Example—Removing a Language
Attribute From All Topics

Your project is in English (United States), but somehow the root English language attribute was
applied to many topics throughout the project. This is evident from a small flag icon at the top of
those topics in the XML Editor.

You want to remove this language attribute so that all topics are using English (United States), set
at the project level.

EXAMPLE Set the fields like this:

n Find

l Attribute

l xml:lang

l en

n Replace/Action

l Remove Attribute

l xml:lang

n Find in

l (whole project)

n File types

l Topics
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Click Replace All.
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Example—Replacing the "Mobile"
Conditional Attribute With "Tablet"

You have a condition tag set named "Default," which holds several conditions, including two called
"Mobile" and "Tablet." In several places in your project, you have applied the Mobile condition to
content. Now you want to replace some of those with the Tablet condition.

EXAMPLE Set the fields like this:

n Find

l Attribute

l Default.Mobile

n Replace/Action

l Set Attribute

l Default.Tablet

n Find in

l (whole project)
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Click Find Next. If the content found is a place where you want to switch to the Tablet
condition, click Replace. Otherwise, click Find Next again. Repeat this until you've set the
Tablet condition on all of the content you want. Save your changes.
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CHAPTER 8

Deprecated Features
Following are features that will be removed in the next release of MadCap Flare, alongside features
that we recommend as replacements. For more information on the replacements, see the Flare
online Help.

Deprecated Features Recommended Replacements

DITA Output Clean XHTML or HTML5 Output

Toolstrip Ribbons

WebHelp and WebHelp Plus HTML5 Output

To provide feedback on these deprecated lists, please send an email to:

supportplanrep@madcapsoftware.com
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials Cheat Sheets
Getting Started Tutorial Context-Sensitive Help Cheat Sheet

Autonumbers Tutorial Folders and Files Cheat Sheet

JavaScript Tutorial Lists Cheat Sheet

Lists Tutorial Micro Content Cheat Sheet

Micro Content Tutorial Print-Based Output Cheat Sheet

Product Foldout Tutorial Search Cheat Sheet

Snippet Conditions Tutorial Shortcuts Cheat Sheet

Word Import Tutorial Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide QR Codes Guide

Analysis and Reports Guide Reviews & Contributions Guide

Architecture Guide Scripting Guide

Autonumbers Guide Search Guide

Condition Tags Guide SharePoint Guide

Context-Sensitive Help Guide Skins Guide

Eclipse Help Guide Snippets Guide

Getting Started Guide Source Control Guide: Git

Global Project Linking Guide Source Control Guide: Perforce Helix Core

HTML5 Guide Source Control Guide: Subversion

Images Guide Source Control Guide: Team Foundation Server

Import Guide Styles Guide

Indexing Guide Tables Guide

Key Features Guide Tables of Contents Guide

Lists Guide Targets Guide

MadCap Central Integration Guide Templates Guide

Master Pages Guide Topics Guide

Micro Content Guide Touring the Workspace Guide

Movies Guide Transition From FrameMaker Guide

Navigation Links Guide Translation and Localization Guide

Plug-In API Guide Variables Guide

Print-Based Output Guide What's New Guide

Project Creation Guide
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